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�FAXmaker - an overview

Introduction

Congratulations on purchasing FAXmaker. FAXmaker for Networks will save your company time and money by offering you advanced network fax technology. With FAXmaker, sending a fax is as easy as printing a document. 

FAXmaker for Networks is designed to integrate seamlessly with Windows NT/95. Therefore this manual assumes that you have Windows NT or 95 installed and running, and that you have a working knowledge of  Windows NT and/or 95.

Requirements

FAXmaker for Networks requires the following;

A Windows NT or 95 machine with at least 16 MB memory and a 100 Mhz 486 processor. The machine does not need to be dedicated to FAXmaker. You can run the FAXmaker server on the file server (providing your file server is running Windows NT or 95). FAXmaker requires very little resources or processing time.

One or more compatible fax devices. FAXmaker supports the following fax devices; Quality CLASS 2 fax modems, ISDN CAPI 2.0 active cards, Gammalink boards, selected class 1 fax modems (not recommended). Although technically speaking you can use any class 2 modem, the reliability (how long you can leave the modem unattended), connect rate (average bps speed at which your faxes will be sent) and connect success percentage (The amount of fax machines the fax modem will  connect to) will depend almost entirely on the quality of the modem you use. We recommend using a quality fax modem such as Zyxel or Multitech. They may cost a little more, but they are well worth the extra money.

A 'shared file area' - a directory which all FAXmaker users can access.

( Why class 2 and preferably not class 1? Class 2 is actually a more advanced protocol, which offloads a lot of the processing time to the modem. This allows your fax server� XE "Fax server" � to use less processor time and to be less sensitive to machine load. The fact that class 1 relies more on the PC processor will mean an increased burden for your server. Furthermore since FAX is a timing sensitive process, your faxes might fail more frequently.

( Although FAXmaker includes a driver for US Robotics, GFI FAX & VOICE do not recommend the use of US Robotics modems.

The FAXmaker system

The FAXmaker system consists of the following parts;

1. A fax server. This program handles all FAX communications & runs on the Fax/file server computer.

2. An MTA (message transfer agent). This program handles the communication between the Fax server and the client software. The program runs on the FAX/File server.

3. Client software - this software allows the user to create a fax, view incoming faxes etc. The software is installed on the actual client machine.

The system is depicted in the following figure:

� EMBED Visio.Drawing.3  ���

Figure 1 shows the FAXmaker fax server/gateway running on Windows NT. 

� EMBED Visio.Drawing.3  ���

Figure 2 FAXmaker running on a Novell,� XE "Novell" � Banyan Vines� XE "Vines" � Network



�Installation

Introduction

This chapter describes the installation of the FAXmaker software on the Fax server. The Fax server is the computer with the fax modem attached. This computer can either be an application server or the actual file server. This computer must run either Windows NT or 95.� XE "Fax server" � 

This chapter will help you choose the installation options available, but will not discuss the user’s and fax configuration options, which are explained in the chapter  ‘User Settings’ and 'Fax server' respectively.

Prior to running the installation procedure, you are advised to read the chapter ‘FAXmaker - an overview’.

Running the installation procedure

1. Insert the disk 1 of the FAXmaker disk set in your disk drive. (If you have a CD ROM version of FAXmaker, insert the CD ROM) Remember that you must run the installation program from the computer with the fax modem(s) attached.

2. Run 'setup.exe'� XE "Setup" \r "D2HBSetup5" � from the File Manager/Explorer or choose 'Run' from the 'File' menu in Program Manager and type in <a:\setup.exe>. If you have FAXmaker on CD ROM, you need to go to the networks subdirectory and start ‘setup.exe’ from there.

3. The setup procedure will now start, and you will be prompted by the installation routine which language you wish to use. Select the right language and click 'Next' to continue.

4. Setup will now request you to close any open programs. When you have done so, click ‘Next’ to continue.

�

User information

5. Setup will now prompt you for your company name, fax number and registration� XE "registration" � number. The registration number is indicated on the disk envelope, or on the CD-ROM cover . If you are evaluating the product, do not enter a registration number. FAXmaker will allow you to setup a maximum of two users.

6. Setup� will now ask you where you want the FAXmaker Fax server files to be installed. 

The location to which you install FAXmaker must be visible to all network users who wish to use FAXmaker! If the clients are using NT, 95 or 3.11 there is no need to make a drive mapping to this area. If one of the clients is running Windows 3.1, you need to make a drive mapping to the FAXmaker directory for that particular computer.

FAXmaker will need approximately 20 Megabytes of free hard disc space.� XE "disc space" � In addition to this you must reserve approximately 40 Megabytes for temporary fax files. Click ‘Next’ to continue.

7. The setup program will now copy all program files to the selected destination.

�

Setup prompts for a fax server service name

If you do not use Windows NT, please go to number 11.

8.  - Windows NT users� XE "Windows NT users" \r "D2HBWindows_NT_u7" � only - FAXmaker setup will now ask you for a FAX service name. There is no need to change the service name, however in certain cases when you are re-installing FAXmaker, you might need to change the name in order not to conflict with the previous FAXmaker service names. Click ‘Next’ to continue.

( To de-install a service, you must delete all references to it from the registry and re-boot. Click ‘OK’ to continue.

9.  - Windows NT users� XE "Windows NT users" \r "D2HBWindows_NT_u7" � only - FAXmaker setup will now ask you for a FAXmaker MTA service name. There is no need to change the service name, however in certain cases when you are re-installing FAXmaker, you might need to change the name in order not to conflict with the previous FAXmaker service names. Click ‘Next’ to continue.

( To de-install a service, you must delete all references to it from the registry and re-boot. Click OK to continue.

10. - Windows NT users only - Setup will remind you that after rebooting your PC, you need to install the FAXmaker printer driver as described in the readme or in the Chapter ‘Installing the client software’.

11. Setup will now finish the installation by creating a FAXmaker program group. This program group includes a number of applets (small applications) which you need to run to complete the installation of FAXmaker for Intranet.

�

The FAXmaker for Networks program group

Setup is now ready copying the files and modifying the registry. To complete the installation and start the operation of FAXmaker for Networks, you must follow the steps outlined in the next paragraph.

Steps to complete installation

Step 1: Reboot your PC

Reboot your PC. This is necessary for the printer driver to be installed on the server machine.

Step 2: Install the FAXmaker Printer driver

If your fax server is running Windows NT 3.51 or 4, you need to install the printer driver as described in the readme, or in the Chapter ‘Installing the client software’ of this manual. If your fax server is running Windows 95, the reboot would have automatically installed the printer driver.

Step 3: Configure the FAX server

Configure the Fax server. You need to setup at least one port (modem or fax board) to start the fax server. This is done using FAXmaker’s ‘Fax Server Configuration’ applet,� XE "configuration applet" � located in the FAXmaker program group. The first time you start it, it will scan your PC for installed modems. You must have at least one class 2 or class 1 modem installed. 

If you have an ISDN card, you must cancel the detection process. The ‘Fax Server Configuration’ utility will automatically start, after which you must click ‘Add’. Now select ‘ISDN controller’ from the list of available devices. 

If you have a Gammalink card, you must cancel the detection process. The ‘Fax Server Configuration’ utility will automatically start, after which you must click ‘Add’. Now select ‘Line 1’ from the list of available devices. The gammalink driver will be installed.

After FAXmaker detects a class 2 or class 1 modem, it will automatically configure the port for you with default settings. Accept these for now and close the ‘Fax Server Configuration’ applet. For more information on the ‘Fax Server Configuration’ applet, consult the Chapter ‘The Fax server’ in this manual.

( If you are using an ISDN or a Gammalink card, check the website (http://www.gfifax.com) for special notes on which drivers to use with these cards.

� XE "user accounts" �Step 4: Create/import user accounts

The fourth step is to create a number of user accounts that will be allowed to send and receive faxes. 

To add more users, select 'Add'. Now enter a user name and click OK. It is important that you use the same user names as they are listed in your network operating system. For example if you have a user John, who listed as John in your Windows NT server or workstation, create a user named John in FAXmaker also. The reason for this is that the FAXmaker security system will compare the NT or 95 login name with the FAXmaker login name. 

After you click ‘OK’, a user setup dialog will appear which allows you to change settings for this user. Accept the defaults for now and click OK.

After creating a few accounts, click ‘Close’ to close the applet. For more information on the applet and the possible user settings, please consult the chapter ‘User settings’.

� XE "FAXmaker Intranet MTA" \r "D2HBFAXmaker_Int8" �Step 5: Start the FAXmaker MTA

You can now start the FAXmaker MTA (Message Transfer Agent). This program will check for outgoing and incoming faxes messages and distribute them to the fax server or the users respectively. 

You can start this program from the FAXmaker program group or from the Services applet in the Control Panel. (Windows NT users only)

( To be able to send and receive faxes, the FAXmaker MTA must be left open on the Fax server.

� XE "Fax server program" �Step 6: Start the FAX server program

Start the FAXmaker fax server. This program handles the sending and receiving of faxes on one or more ports. You can start this program from the FAXmaker program group. If you have Windows NT, you can also start this program as a service from the services applet in the control panel.

( To be able to send and receive faxes, the FAXmaker Fax server must be left open on the Fax server.

You can monitor the fax server using the ‘Fax server monitor’, which displays port activity and modem status.

( If you want to run the FAXmaker Fax server as a service, you must enter an account that has rights to log on as a service. This is done by highlighting the FAXmaker Fax server service and clicking ‘Startup’.

�

The Windows NT services applet

�

The ‘Startup’ dialog of the FAXmaker Fax service.

( To have the FAXmaker Fax service start up automatically, change the Startup type setting to ‘Automatic’.

� XE "installation" �� XE "OCR routing" �Installation of the OCR routing module



THIS SECTION IS ONLY APPLICABLE TO FAXMAKER USERS WHO HAVE PURCHASED THE OCR MODULE.

FAXmaker users can opt to purchase an OCR module, that can automatically route� XE "Route" � incoming faxes to the right recipient, and will allow you to convert a fax to text format. With this module, the fax server will scan the incoming fax for a recipient name, and if it finds a recipient's name, FAXmaker will automatically route that fax to the recipient's mailbox.� XE "Mailbox" �

The module includes 2 OCR support disks, as well as a revised serial number. 

To install the module, run a:\setup.exe� XE "Setup" \r "D2HBSetup11" � from the file run command in the Program manager menu. 

Follow the instructions explained during the installation. 

You will now be able to setup OCR routing per user from the User setup utility,� XE "administrator" � by going to the “OCR tab” in the routing setup.



�User Settings

Introduction

All network users who wish to be able to send and receive faxes must be added in the ‘User Configuration’ utility. 

This utility can be started from the FAXmaker program group.

�

User configuration utility

Creating users from the FAXmaker ‘User Configuration’

If your server is running Windows NT 4, you can automatically import the users from NT. To do this select ‘import users’, and select the users you wish to add.

If you do not have Windows NT 4, you must add the users manually. To add users manually:

1. Click ‘Add user’. You will be asked to enter the user name as well as his or her e-mail account.  If the user does not have an e-mail account, leave this box empty. 

�

Adding a user account

2. Click ‘OK’. The user will be created, and the user settings dialog will appear automatically.

User settings

To configure the user's settings highlight the user name and select 'Properties'. The following options will be available.

�

The user settings

Send Options

Normal resolution/High resolution - Select the default resolution to send faxes in. Users can override this by specifying a different resolution in the body of the message. (See fax options� XE "FAX options" � in the “Sending and receiving faxes” chapter).

Personal FAX header� XE "FAX header" � - activating this option will include the sender’s name on top of the FAX. This will allow recipients of the FAX to identify the sender. 

Receive Options

Include fax files with notification - When a fax is transmitted, a user can choose to receive the converted fax file for backup/confirmation purposes.

Receive incoming faxes - This option specifies that this user must receive all incoming faxes, so that she/he can route� XE "Route" \r "D2HBRoute11" � faxes to the right users.

Include/Exclude routed faxes - When receiving all incoming faxes in one mailbox, this option allows you to specify whether to include or exclude faxes for which a recipient already has been found, using available routing methods.

Routing

FAXmaker can automatically route an incoming fax to the right person. There are a number of ways to achieve this: CSID routing, DTMF/DID routing and OCR routing.

�

Routing options available for each user

CSID routing - this method relies on the FAX ID� XE "Fax ID" � which each FAX machine/FAX card displays when sending a FAX. Since it rarely changes, it can be used to identify the sender and thus the corresponding recipient. 

�

Routing a fax using the FAX ID (CSID)

How to set up CSID

You can setup� XE "Setup" \r "D2HBSetup16" � CSID routing by adding CSIDs (FAX IDs) to a user’s CSID list. FAXmaker will then route incoming faxes with that particular CSID to that user.

Automatic Updating of the user’s CSID list.

Activating the option ‘Store CSIDs of all outgoing faxes in list’ will automatically update the user’s CSID list. Each time a user sends a fax, the CSID of the recipient(s) will be stored in the CSID list. This technique relies on the fact that if a user sends a fax to a particular fax machine, he is likely to be the recipient of the answer to the fax. If you enable this option, each time the user sends a fax, the CSID of the receiving fax is stored in the user’s CSID database.

DTMF routing - DTMF (Dual Tone Multi Frequency) tones are the tones generated by a telephone handset, and can be used to identify a recipient. The DTMF number can be appended after the regular fax number. The system works in the following way: the caller dials the fax number and waits until the call is answered. The fax card will now transmit a tone, after which the caller must enter the DTMF routing number. The FAXmaker server will recognise the DTMF number and use it to identify the recipient of the fax.

DTMF routing can work well, if you explain your callers how to use it. This can be done on the FAX coverpage of outgoing faxes. DTMF routing can also be used behind a PBX which supports DID. In this case you can use excess DID lines from the PBX to route the FAX to an extension.

�

Routing a fax using DTMF/DID routing

DID routing (Direct Inward Dial) - DID routing is generally considered the most reliable form of automatic inbound� XE "Inbound" �� XE "Inbound router dialog" � routing, because it relies on information provided by the telephone exchange, not on information provided by the caller. DID requires you to purchase ‘virtual phone numbers’ from your telecom company, which you can assign to users or departments. The virtual phone number (DID number) will be passed to FAXmaker so that FAXmaker knows to whom the fax should be routed. A DID number is passed using either a PBX with DID capability, or a fax card with DID as a DID device. These devices must pass the DID number to FAXmaker as a series of DTMF tones. The system is completely transparent to the caller and does not require any effort on his part.  

How to set up DID and DTMF

To set up both DID and DTMF routing, go to the DID/DTMF� XE "DID/DTMF" � tab in the routing dialog. Fill in an appropriate routing code for the user. Remember that actual activation of DID or DTMF routing is done in the FAX server.� XE "Fax server" � The administrator� XE "administrator" � only stores the users’ routing code. The same routing code can be used for both DID or DTMF routing.

( If you are going to use an ISDN card to perform DID routing, please refer to the ‘FAX server’ Chapter for more information how to setup this up.

�

The OCR routing properties dialog

OCR routing - OPTIONAL MODULE - Another easy way to route faxes automatically is using OCR. This system will OCR the first page of a fax, and consequently search the fax for a recipient name. If it finds one, it will route the fax to the recipients mailbox.� XE "Mailbox" � If it does not, it will route the fax to the default mailbox. This option requires the optional OCR module.

�

Routing a fax using OCR

How to set up OCR

To set up� XE "Setup" � OCR routing, click the OCR set up button in the Routing tab. 

This dialog has two tabs:

1.  Greeting - meaning that the FAX server will search for a greeting such as Dear, Mr., Ms., etc., before the actual user name. This means that the FAX server will only attempt to recognise a user name after it has recognised a  greeting word. You can add and remove greetings by clicking the add and remove buttons. You can enter a matching ratio. This allows you to specify the confidence FAXmaker must have before it will actually recognise it as a greeting. Using this option you can tune the system to your specific needs. For normal use, a low setting is required, since greetings are short, and a lower matching ratio allows for OCR mistakes, and for 'spelling mistakes'.

2.  User keywords� XE "keywords" � - here you can enter keywords per user, which FAXmaker will search for to identify the recipient of a FAX. If, for example, an individual Mr. Johnson, is also known as John, this keyword may be entered also, as well as Mr. Johnson. In addition, if Mr. Johnson is responsible for international sales, one might add international sales as a keyword too. A matching ratio can be entered to tune the system. 

Call blocking

�

Call blocking properties

Call blocking allows you to exercise control over the fax numbers that the users can send to. To enable this option, activate the ‘Disallow numbers to dial out’ radio box at the bottom of the dialog. You can now add numbers to the list which may not be dialled by the user. FAXmaker will check the list before each fax transmission, and not send any faxes starting with numbers listed in the call blocking list. This means that if you want to disallow certain users making international fax transmissions, you only need to insert the international dial out number (for example 00, 09 or 011). Alternatively you can block specific fax-numbers. 

User info

�

The user info properties.

This tab allows you to enter additional information regarding the user. This information is used for filling in coverpages and/or templates� XE "templates" \r "D2HBtemplates19" � with the sender’s information.

The fields in the dialog correspond with the following coverpage and template fields.



User properties�Merge field��Lastname�<S_Lastname>��Firstname�<S_Firstname>��Name�<S_Name>��Company�<S_Company>��Department�<S_Department>��Fax�<S_Fax>��Voice�<S_Phone>��Email�<S_Email>��Coverpages & Templates

A number of coverpages and templates can be used for sending faxes. The administrator can do this from the ‘Template’ properties dialog.

�

The Coverpage and Template properties dialog

Using a coverpage or a template



If you are NOT using FAXmaker integrated with Windows Messaging: 

Do not use the ‘Coverpage Setup’ in the FAXmaker ‘User Configuration’ applet, as FAXmaker will only make use of templates. When a user instructs FAXmaker to send a coverpage in the ‘Send Fax’ dialog, FAXmaker will in fact use the defined template to send it out. The result will be the same as using a coverpage, namely the RTF Template file will be merged with the recipient information and the message text, and will be sent out before the other pages.

If you are using FAXmaker integrated with Windows Messaging:

You can use both the ‘Coverpage Setup’ and the ‘Template Setup’ in the ‘User Configuration’ applet. However, in practice template files will be used most often, because when sending a fax from Windows Messaging, the e-mail message text and sender information will be merged with the defined Template file. Only if a user wants to send another page in front of that page, the user can make use of a coverpage.

( There is no actual difference between a Template file and a Coverpage file. They are both stored in the same directory ‘Coverpge’ and are both RTF files. However, the difference is that a Template is stored as a Template file within the ‘User Configuration’ and a coverpage is stored as a Coverpage file within the ‘User Configuration’. 

Adding templates or coverpages

FAXmaker ships with a number of sample templates and coverpages. By default, FAXmaker will use the file template.rtf� XE "rtf" \r "D2HBrtf18" � (located in the FAXmaker-coverpge subdirectory) as a template for all users.

By modifying template.rtf you can avoid configuring a template file for each user. 

To add a custom coverpage or template:

1. Design your coverpage/template in your word processor and save it as an RTF (Rich Text format) file (i.e. with extension ‘.rtf’). For more information on designing a coverpage/template, turn to the chapter ‘Designing Coverpages & Templates’.

2. In the ‘Templates’ properties dialog, click ‘Add’ in either the Coverpage Setup or the Template Setup, and select the RTF file you created.

3. If you wish to set this RTF file as the default, click ‘Set Default’.

Options dialog

This dialog allows you to set-up the integration with Windows Messaging. For more information see “FAXmaker & Windows messaging”.

�� XE "Fax server" �The Fax Server

Introduction

The Fax server program� XE "Fax server program" � is the core of FAXmaker. It is fully multi tasking and will handle sending and receiving of faxes simultaneously. The Fax Server can run as an application or as a service. Setup of the Fax server is performed from the FAXmaker ‘Fax Server Configuration’ applet.� XE "configuration applet" \r "D2HBconfiguratio21" �

�

The FAXmaker fax server configuration� XE "Server configuration" � applet

� XE "registration" \r "D2HBregistration21" �Registration

Before you setup the fax server, enter your registration number in the register dialog. This registration number will also allow you to upgrade to more users or add additional modules. To read more about the upgrade options of FAXmaker, please visit our web site at http://www.gfifax.com.

To enter the registration number;

1. Click on ‘Register ‘.

2. Enter your company name and registration number Click ‘OK’ to continue.

( If you are evaluating FAXmaker for Networks, leave this field empty and test FAXmaker with two-users maximum.

( Please take some time to register your product using the WWW form on our site: http://www.gfifax.com/pages/regfrm.htm. This will also allow you to request support.

Configuring the Fax Server

Before you start the Fax Server, you must configure the 'Ports' that you will be using in the Fax server. A port� XE "port" \r "D2HBport17" � is a COM port with a modem attached or a fax line on a fax/ISDN board. To configure a port:

1.  Start up FAXmaker’s ‘Fax Server Configuration’ applet.

The first time you start it, it will automatically scan your PC for an available port. You can cancel this process by clicking ‘Cancel’.

�

FAXmaker detecting a fax device

FAXmaker will try to detect a modem installed on your PC.

If you are going to use an ISDN or Gammalink card, cancel the autodetect process. The ‘Fax Server Configuration’ utility will automatically be displayed. Now select ‘Add’. You will be able to select from a list of compatible fax devices. If you are going to use an ISDN card, select ISDN controller. If you are going to use a Gammalink card, select ‘Line 1’. The setup for the card will appear automatically.

( If you have cancelled the scanning of ports earlier, or have installed an additional modem or board, you can select ‘Add’ to create an extra port. You will be able to choose from a list of fax devices.

2. You can specify the port settings by double-clicking on a port or selecting a port and clicking ‘Properties’.

3. A tabbed dialog will appear, which allows you to specify modem, fax, printing, routing and archive� XE "archive" � options for that port. If you have OCR installed, an OCR tab will also appear.

�

The modem properties  tab

Modem Properties

This tab allows you to configure your modem. 

Modem control

Modem type - Select your modem from the drop down list box.

Initialisation string - Although the initialisation string does usually not need to be changed, you can edit the string in this field.

Line options

Tone dialling - Activate this check box if you can use tone dialling. If you deactivate it, the Fax server will use pulse dialling. 

Wait for dial tone - If you activate this option, the fax server will only send the fax if the modem detects a dial tone. 

( Some export� XE "Export" � modems do not recognise the dial tone, so you must first test whether your modem recognises a dial tone. If it does not, deactivate this option.

Check for busy tone - Activate this option if you want the modem to check for a busy tone.

Speaker mode - Select whether you want the speaker to be 'Always Off', or 'On until connected' or 'Always On'.

Speaker volume - Select the appropriate volume. 

�

The fax setup� XE "Setup" \r "D2HBSetup26" � tab

Fax Setup

General options

Maximum Speed - Select the send and  receive speed according to your modem's capabilities. Remember that not all modems are able to negotiate “down” well, so choose 9600 if in doubt.

Local ID- Enter the fax ID. The recipient will see this as the identification code of the fax.

Send options

Send outgoing faxes - This radio box allows you to determine whether this port/modem should send faxes. This is useful when you want to use one port or modem for receiving faxes only.

Dial prefix - If your lines are located behind a PBX, you can specify a dial prefix here.

Number of retries - Sets the number of times FAXmaker will try to send a fax.

Retry delay - This option allows you to set a delay between retries in seconds.

Fax header� XE "FAX header" � - The fax header is a word or company name which will appear on top of each fax.

Receive options

Answer incoming calls - For the fax server to be able to receive faxes, this option must be checked. Specify after how many rings you want FAXmaker to answer in the 'Rings until answer field'.

Attach OCR document - If you have the OCR module installed, you can select this option to have the OCR text output attached to the incoming fax.

Incoming call detection� XE "Incoming call detection" � - By default the fax server will answer all incoming calls as fax only. However, if you have installed the voice mail� XE "voice mail" � or Fax on demand� XE "fax on demand" � module (optional module), you can have the fax server detect between fax/voice or voice only calls. 

�

The routing setup tab

Routing

Inbound� XE "Inbound" �� XE "Inbound router dialog" � routing of faxes is set up in the ‘User Configuration’ applet,� XE "administrator" � however you must activate the various routing methods in the server in the ‘Routing properties’ tab. Activate a routing method by clicking on the appropriate radio box.

( Do not enable DTMF routing unless you have a compatible voice modem correctly setup. Compatible voice modems are Zyxel or modems that have a Rockwell voice chipset. You must also select the corresponding driver in Modem properties as either Voice modem (Rockwell) or Zyxel. If you enable DTMF routing without having a voice modem, the fax server will generate an error whilst receiving.

DTMF options

Generate beep - you can instruct the Fax server to generate a beep when it picks up the line. This will alert the caller or PBX to enter the DTMF string.

Number of digits - Length of DTMF string/number that caller or PBX must generate.

�

Autoprint properties

Autoprint incoming faxes

The printing options dialog allows you to configure automatic printing� XE "automatic printing" � per port.� XE "port" \r "D2HBport21" � That is, you can select either the same or different printers to service the printing requests from various ports. Both incoming and outgoing faxes can be printed automatically. Printing of outgoing faxes is configured in the general setup� XE "Setup" \r "D2HBSetup28" � because it is not port specific.

�

Archiving properties

� XE "archive" �Archive

This tab allows you to specify the archive options. Archiving allows you to create a backup of all incoming and outgoing faxes.

If you have the OCR module installed, FAXmaker will store the OCR text output in the same directory, using the same file name as the corresponding fax file, but using extension *.txt instead of *.fax.

Archive incoming - Archives all incoming faxes in a directory of your choice.

Archive outgoing - Archives all outgoing faxes in a directory of your choice.

Configuring an ISDN card

Skip this paragraph if you do not have an ISDN CAPI 2.0 card. 

The setup of the ISDN card is quite similar to the setup of a modem. 

ISDN card send receive options

First of all select the appropriate ISDN card from the list of available ISDN card drivers. Because the currently available cards differ in their specifications, some send and receive options may not be applicable to your card. For the latest information regarding ISDN cards and FAXmaker, please check our web site http://www.gfifax.com.



�

The ISDN card properties  tab

MSN number setup

You must specify which MSN numbers FAXmaker must answer. For example, if you wish that FAXmaker only answers the number 040-306810-10, then you must enter it here. 

( If you do not enter any number here at all, FAXmaker will not answer incoming calls!

If you wish that FAXmaker answers a whole range of numbers (for example if you are using DID routing), just enter the starting number of the range of numbers. For example: to instruct FAXmaker to answer all numbers 306810-10 up to 306810-19, enter ‘306810-1’ in the MSN number setup dialog.

Configuring routing with ISDN

After configuring the MSN numbers, you can setup automatic routing of faxes. This is done using the DID routing feature. (In the UK, DID is referred to as DDI). To configure routing with ISDN;

1. Make sure the MSN numbers have been entered.

2. Switch on DTMF/DID routing in the routing tab.

3. Specify the number of digits that FAXmaker should use. For example if your DID numbers are 306810-10 to 306810-19, then specify 2 digits. This means that FAXmaker will only ‘analyse’ the last two digits of the number and try to match it with a user’s DTMF/DID routing number. This number is entered in the ‘User Configuration’ utility, under the routing tab.

Configuring a Gammalink card

Skip this paragraph if you are not using a Gammalink card. 

To add a Gammalink card, simply select ‘Line 1’ from the list of compatible fax devices. This will automatically add the Gammalink driver. A tabbed dialog will appear in which you have the same fax, OCR, routing, call blocking and archiving options as for modems. For more information on these settings please see the first part of this chapter.

�

The FAX board properties  tab

� XE "rtf" \r "D2HBrtf27" �RTF converter setup

The RTF converter converts coverpages and e-mail messages to fax, using a customisable RTF file as a template. The converter options are changed from the ‘Fax Server Configuration’� XE "Server configuration" � applet. 

�

RTF converter setup

To change RTF conversion options:

1. Click the RTF setup button at the bottom of the list of ports.

2. A dialog appears which allows you to specify the margins that you wish to use. It is important to take these margins into account when designing your cover page.

3. The default page size cannot be changed. The list box has been included to indicate that you must set the page size of your RTF template to 81/2 by 11 inches. (Standard US size) This will in no way effect your fax transmissions.  � XE "cover page" �

General options

The general setup contains general options which are not specific to a port. To change general options;

1. Click the general button at the bottom of the list of ports.

2. A dialog appears which allows you to specify general options;

�

The general options dialog

Autoprint outgoing faxes

Autoprint outgoing faxes  - This option automatically prints all faxes that are sent successfully. You can select a printer on which all faxes from the list box will be automatically printed.

Print report if successful - If this option is activated, FAXmaker will print a transmission report and a miniature of the fax after successfully sending a fax. You can also specify how many pages you wish FAXmaker to include in the miniature print out (maximum of 4 pages).

Scan directory for text files

This option allows you to send faxes programmatically, by posting a correctly formatted text file in the ‘scan directory’. In this way you can integrate FAXmaker with a Web server, and allow a custom CGI script to send a fax automatically.

To send out a text file automatically:

1. Create a text file with your message text in it.

2. Add a line at the top of the text, starting with a double colon ::, specifying the recipients name (optional) and company and the fax number. For example:

::Mr Johnson, GFI, 661072

3. You can add additional send options by adding a second line, preceded by a double colon, specifying valid send options as described in the ‘Sending and Receiving Faxes’ chapter.

If the fax is transmitted successfully, the extension of the fax file name will be changed to *.suc. If the fax has failed, the extension will be changed to *.err. This allows you to give feedback to the user of your program.

Text files are formatted using an rtf file as a template. This way you can add your company logo and address details etc. to the text file. The rtf file is called txttmpl.rtf and is located in the coverpage directory. To change this template, simply edit txttmpl.rtf and save it with the same name in the same directory.

Configuring the document converter

FAXmaker is able to convert attachments such as Word files to fax format, using its document converter interface. 

Requirements of the document converter

FAX server must be running on Windows NT 4 or 95.

An application that supports the same format, for example in the case of Word files, Microsoft Word must be installed and running on the server.

The application must install a print shortcut - in other words, the application must support automatic printing from the Windows explorer. The application must not pop up a print to dialog which requires user intervention. To check whether your application supports ‘automatic printing’, start up Windows explorer and right-click on a file in the applications file format. A print command must be available. Activate it and check whether further user intervention is required simply by printing it to file. If this is not the case, please consult your Windows NT or Windows 95 manual to find out how to set this up.

The FAXmaker printer driver must be set as the default printer on the NT server/Windows 95.

The FAX server must be run as a desktop application, i.e. not as a service. This is required because a service cannot interact with an application. To do this, run the FAXmaker fax server with the -desktop option from the console (NT command prompt).

Adding additional formats

To add additional formats, you must edit the fgwmserv.ini file which is located in the Windows NT 4 or Windows 95 directory. Under the heading ‘Allowed Extensions’, add the file extension and the shortcutname (usually ‘Print’) that FAXmaker must use.

[Allowed extensions]

DOC=Print

If you do not have a ‘Print’ shortcut installed, you can create it yourself.

US date format in fax header

The FAXmaker fax header is as default set to the European date format. 

To make the FAX header appear in US date format;

Open the fgwmserv.ini file (located in the Windows NT directory) with notepad, and search for;

UsaDateFormat=0/1

To switch on US date format, set the value to one. This setting should be changed for each COM port.

� XE "Monitor" �The FAX Server Monitor

The ‘Fax server monitor’ allows you to monitor the status of the fax server. The top pane shows the activity on each of the ports, and the bottom pane displays a detailed error log.

�

The Fax server monitor

The ‘Fax server monitor’ can be started from another PC as well, however the error log will not be listed.

Aborting a fax

To abort a fax, select the appropriate port and choose ‘Abort’ from the port menu.

The Queue view utility

FAXmaker includes a queue view utility which allows you to see which faxes are queued to be sent at the server level. When a fax has been submitted to be sent, the only way to delete it is using this queue view utility! The queue view utility can be started from the FAXmaker for Networks server program group.

�

The queue view utility

Running the fax server as an application

The FAXmaker fax server can be run as an application from the FAXmaker program group or as a service from the services applet.

The FAXmaker fax server can also be run from the console/command prompt by specifying <-desktop>. For example;

fgwmserv -desktop

This will start the FAXmaker fax server as an application and allow you to quickly start and stop the fax server.



�Installing the Client software

Introduction 

After installing the Fax server,� XE "Fax server" � you need to install the client software on the users workstations.

In most cases this setup can be performed by the users themselves.

Installing Windows 3.1 or 3.11 clients

1.  Run <setup.exe>, located in the FAXmaker\client\win 3.1 directory, by using the 'Run' command from the 'File' menu in Program Manager. 

2.  Follow the installation instructions displayed in the installation dialogs. Setup will copy a number of files to the directory FAXmaker, located under your Windows directory.

3. Setup will prompt you for a user name and your password. This password will be used to secure your mailbox. The user name must be the same as specified in the ‘User Configuration’ program. If in doubt, check with the administrator.

4. Reboot your machine after completing the installation. 

�

The Windows 3.1 and 3.11 mailbox prompt

Installing Windows 95 clients

1.  Run <setup.exe> located in FAXmaker\client\win95 directory by using the 'Run' command from the 'File' menu in Program Manager.

2.  Follow the installation instructions displayed in the installation dialogs. Setup will copy a number of files to the directory FAXmaker, located under your Windows directory.

3. FAXmaker setup will ask you which viewer you wish to use to view faxes. FAXmaker includes a standard fax viewer, but if you have WANG imaging installed on Windows 95, FAXmaker can offer advanced viewing facilities such as Annotation.

�

Setup asks which fax-viewer you would like to install.

The WANG imaging viewer is available for Windows 95 and NT 4. It can be downloaded free of charge from http://www.wang.com and http://www.microsoft.com.

In later versions of Windows 95 and in Windows NT 4, the Wang imaging viewer is an installation option. Before selecting the advanced viewer, check whether you have Wang imaging installed.

4. Setup will prompt you whether you wish to send and receive faxes using Windows messaging. Windows Messaging is the email system included in Windows 95 and NT 4, and FAXmaker can use this system so that you will be able to send and receive faxes from it. If you prefer to use the Windows messaging (formerly Exchange client) as an interface, select use Windows messaging.

�

Setup asks which if you ant to use Windows messaging 

5. Setup will prompt you whether you wish to load the FAX manager automatically. This will allow FAXmaker to pop up a message box when you receive a new fax. 

�

Setup asks if you would like to load the fax manager automatically.

6. Setup will prompt you for a user name. By default it will display your network user name. Do not alter this name unless you are the network administrator. Click ‘OK’ to continue.

�

Setup asks for your login name.

6. Reboot your machine after completing the installation.

� XE "Windows NT" \r "D2HBWindows_NT23" �Installing Windows NT 3.51 clients

1.  Run <setup.exe> located in the FAXmaker\client\winnt\winNT35 directory by using the 'Run' command from the 'File' menu in Program Manager.

2.  Follow the installation instructions displayed in the installation dialogs. Setup will copy a number of files to the directory FAXmaker, located under your Windows directory.

3. Setup will prompt you for a user name. By default it will display your network user name. Do not alter this name unless you are the network administrator. Click OK to continue.

4. Reboot your machine after completing the installation.

Installing the Windows NT 3.51 fax printer driver

After running the FAXmaker Windows NT Install program & rebooting your machine, you must install the fax printer driver from the Print Manager. 

To create a printer, you must be logged on as a member of the Administrators, Server Operators, Print Operators, or Power Users group. 

1. Start the Print Manager from the Control Panel or Main group.

2. From the Printer menu, choose ‘Create Printer’.

3. In the Printer Name box, type FAXmaker.

�

The Windows NT create printer dialog

4. Install the FAXmaker printer driver: in the ‘Printer Properties’ dialog box, select ‘Other’ in the Driver box. 

5. In the ‘Install Driver’ dialog box, specify the drive and path where the FAXmaker\client\winnt\winnt35 directory is located, for example:

FAXmaker\client\winnt\winnt35 and choose the ‘OK’ button. 

6. In the Select Driver dialog box, select the FAXmaker driver. Then choose the ‘OK’ button. 

7. The driver will now be installed by FAXmaker. 

8. In the Driver box, select the FAXmaker printer driver ‘FAXmaker’. 

9. In the ‘Print To’ box, select ‘GFIFAX:’. (This port� XE "port" � should have been automatically added after you rebooted the system). 

10. In the ‘Create Printer’� XE "Create Printer" � dialog box, choose the ‘OK’ button. 

11. This completes a basic printer installation. Once a driver is installed, Print Manager automatically displays a dialog box allowing you to set up the features of your printer. There is no need to change any of these options. 

Installing the Windows NT 4 clients



1.  Run <setup.exe> located in the FAXmaker\client\winnt\winNT40 directory by using the 'Run' command from the 'File' menu in Program Manager.

2.  Follow the installation instructions displayed in the installation dialogs. Setup will copy a number of files to the directory FAXmaker, located under your Windows directory.

3. FAXmaker setup will ask you which viewer you wish to use to view faxes. FAXmaker includes a standard fax viewer, but if you have WANG imaging installed on Windows 95, FAXmaker can offer advanced viewing facilities such as Annotation.

The WANG imaging viewer is available for Windows 95. It can be downloaded free of charge from http://www.wang.com and http://www.microsoft.com.

In later versions of Windows 95 and in Windows NT 4, the Wang imaging viewer is an installation option. Before selecting the advanced viewer check whether you have the Wang imaging installed.

4. Setup will prompt you whether you wish to send and receive faxes using Windows messaging. Windows Messaging is the email system included in Windows 95 & NT 4, and FAXmaker can use this system so that you will be able to send and receive faxes from it. If you prefer to use the Windows messaging (formerly Exchange client) as an interface, select use Windows messaging.

5. Setup will prompt you for a user name. By default it will display your network user name. Do not alter this name unless you are the network administrator. Click OK to continue.

6. Reboot your machine after completing the installation.

Installing the Windows NT 4 fax printer driver

After running the FAXmaker Windows NT Install program, you must install the fax printer driver from the Print Manager. 

To create a printer, you must be logged on as a member of the Administrators, Server Operators, Print Operators, or Power Users group. 

Go to the ‘Add printer’ wizard located in the ‘Printers folder’ in the control panel.



( You may need your Windows NT 4 install disks at hand.

1. Start ‘Add Printer’

2. Select 'My Computer'

�

Selecting the ‘My Computer’ option

3. Select ‘Next’

4. Select ‘GFIFAX’ from available ports list. This port will only appear after running the client installation and rebooting your machine after installation.

�

Selecting the GFIFAX port

5. Select ‘Next’.

6. The printer selection dialog will appear. Select 'Have Disk'

7. Enter the path to the FAXmaker NT driver directory; namely FAXmaker\client\winnt\winnt4.

8. Choose ‘OK’

9. Verify FAXmaker printer driver appears in Printer dialog.

10. Choose ‘Next’.

11. The ‘Add Printer’ wizard will prompt you to insert the Windows NT 4 CD ROM. However, if you have an English installation, you can simply delete i386 from the path that is prompted’ and use the files supplied by the FAXmaker install.

Click ‘OK’ to continue.

12. You may choose to use FAXmaker as your default printer driver.

13. Click ‘Next’.

14. Choose ‘Not shared’.

15. Click ‘Next’.

16. Do not print a test page.

17. Choose ‘Finish’.

�Windows Messaging FAX gateway

Introduction

FAXmaker for Networks can integrate with Windows Messaging, acting as an email to fax gateway. Using this feature, users can send and receive faxes from within the Windows 95/NT 4 Windows Messaging client (formerly MS Exchange). In this setup, FAXmaker acts as a FAX gateway for Windows Messaging.

This feature requires the machine on which FAXmaker is installed, to be running either Windows NT 4 (workstation or server) or Windows 95. This feature is NOT supported on servers running Windows NT 3.51.

The advantage of this is that you can use the MAPI address book and mail features to send and receive faxes.

System architecture

The FAXmaker server acts as a gateway to the e-mail system� XE "Mail system" \r "D2HBMail_system37" � using a mailbox� XE "Mailbox" \r "D2HBMailbox37" �� XE "Mailbox" � on the e-mail system itself, called ‘Faxserver’.

All faxes which are to be sent by the Faxserver, and all incoming faxes which are to be routed via the e-mail system, are sent from the Faxserver mailbox/user account.

In actual fact, the Faxserver is a user on the system which sends and receives mail just like other users. Windows Messaging must be installed on the fax server for the e-mail gateway to function. Furthermore a user ‘Faxserver’ must be created, and a profile with which the fax server can login automatically to the postoffice.

Set-up of the Windows messaging FAX gateway

To use Windows Messaging for sending and receiving faxes, you need to follow four steps (explained in more detail in the next paragraphs): 

1. Ensure that Windows messaging is correctly setup and working on the fax server. There is no need to setup a new post office� XE "Post office" \r "D2HBPost_office37" � or gateway in the e-mail system. For more information on setting up Windows Messaging, please refer to the Microsoft documentation.

2. Create a user called ‘Faxserver’. Test whether this user can send and receive e-mail.

3. Create a profile for the Faxserver in which you have specified post office location etc. 

4. Activate the e-mail option in the ‘Options’ dialog of the FAXmaker ‘User Configuration’ applet. If you have named your profile other then ‘Faxserver’, you need to alter the name here too.

�

Windows 95 control panel

Creating a Fax server user

1. Start-up the control panel applet in Windows 95/NT4.

2. Double-click the ‘Microsoft Mail Post office’ icon. The ‘Post office Wizard’ will start and prompt you whether you want to create or administer a post office. If you already have your system installed and running, select ‘administer’, otherwise create a new post office (available to all users). Be sure that you have rights to administer the post office!

3. You will be asked for a post office location. Click ‘browse’ if you are not sure where it is. A post office directory is usually called similar to ‘G:\WGPO0001’. Click ‘next’ after entering the location.

4. You will now be prompted for a mailbox� XE "Mailbox" � name and a password.� XE "Password" �� XE "Password" � In most systems, the ‘mailbox name’ is the same as the ‘user name’. 

5. If you have correctly entered the name and password, the ‘Post Office Manager’ will now start up. The Post Office manager lists all users in the system and allows you to add and remove users.

6. Click the ‘Add User’ button. The Add User dialog will appear. Enter the name ‘FAXserver’ for both mailbox and name. Optionally you may enter a password. If you enter a password, remember that the fax server will not be able to load automatically, because it will prompt you to enter a password!

7. Click ‘Close’ when ready. You have successfully created a Faxserver user.

Creating a Faxserver profile

After creating the Faxserver user, you need to create a profile for the Faxserver user. A profile is a set of configuration options used by Windows Messaging that contains essential information, such as which information services you are using. This information includes the location of your Inbox, Outbox, address lists, and the personal folder files available to the Faxserver for storing and retrieving messages and files.

To create a Faxserver profile:

1. Start-up the control panel applet in Windows 95/NT4.

2. Double-click the ‘Mail and Fax’ icon.  If you have not created any profile yet on the computer, it will start up the Inbox Setup “Wizard”. If you already have a profile, The ‘Microsoft Exchange Settings’ properties dialog pops up, showing the properties of the active profile. In this case, you need to select ‘Show profiles’, and click Add, after which the ‘Inbox Setup Wizard’ will start.

�

The profile list dialog

3. The ‘Inbox Setup Wizard’ will ask you which information services you wish to setup. Select ‘Microsoft Mail’ only and click Next. If you have ‘MS At work Fax’ installed, remove it.

�

4. In the ‘Profile Name’ box, type ‘Faxserver’. If you already have a profile installed, the wizard will prompt you for a profile name. Otherwise continue and rename profile to Faxserver afterwards, using the Copy Profile command.

5. The ‘Inbox Setup Wizard’ will now ask you for the post office� XE "Post office" � location. Enter the post office location as you did when creating the Faxserver user.



The inbox setup wizard

6. The ‘Inbox Setup Wizard’ will ask you for a user name. Select Faxserver. If you entered a password when setting up the FAXserver user, you will need to enter it here.

7. The ‘Inbox Setup Wizard’ will now ask you for a path and a file name for the personal address book. Confirm the default suggestion.

8. The ‘Inbox Setup Wizard’ will now ask you for a path and a file name for the personal information store. Enter a destination and file name. 

9. Click ‘Finish’. The profile has now been setup. If you named the profile anything else then ‘FAXserver’ remember to change the setting in the options� XE "Mail system" \r "D2HBMail_system40" � dialog of the ‘User Configuration’ utility.

Switch on the Windows Messaging gateway

After setting up Windows messaging, you must activate the Windows messaging gateway in the server. This is done from ‘Options’� XE "Mail system" \r "D2HBMail_system40" � dialog of the ‘User Configuration’ utility.

�

Activating the Windows messaging gateway

Setting Poll time in Windows messaging

By default the Windows messaging “poll time” (the interval in minutes that it checks for new mail) is 10 minutes. This means that the fax server will receive notification of new faxes to be sent every 10 minutes. If you send out faxes regularly via Windows Messaging it is better to decrease the interval to 1-5 minutes.

� 

The MS Mail delivery settings dialog

To do this, double-click on the ‘Mail and Fax’ icon, click on ‘Show Profiles’ and select the Fax server profile. Click on ‘Properties’, and select ‘Microsoft Mail’.

Select ‘Properties’ again, and click on the ‘Delivery’ Tab.

Now change the setting in the “Check Mail every X minutes” to your preferred interval.

Sending faxes from the Windows Messaging client

After you have setup Windows Messaging and FAXmaker from the server side, you need to setup the workstations. To do this, simply install the FAXmaker client software and select the ‘Use Windows messaging’ when prompted. For more information please see the chapter ‘Installing the client software’.

Sending a fax from an application

To send a fax from any Windows application, print to the FAXmaker printer driver. The FAXmaker ‘Send Fax’ dialog will appear after which you can enter the recipient information and send the fax.

The fax will actually be sent using Windows Messaging, and will appear as a message in your outbox. You will receive a notification in your inbox when the fax has been successfully sent or when it has failed.

Using the Windows Messaging address book

You can access the Windows Messaging address book from the FAXmaker ‘Send Fax’ window. However you can only use recipients that are stored in a particular way in the address book, namely as ‘Other address’.



�

Click on ‘New’ in the Windows Messaging ‘Address Book’

To make new fax recipients, go to the Windows Messaging Address Book (choose ‘Address Book’ from the ‘Tools’ menu), and select ‘New Entry’ from the ‘File’ menu. You can also open a new message, and click on the ‘To:’ field, and then on ‘New’.



�

Select ‘Other Address’ to store a Fax recipient.

Now select ‘Other Address’ to store a FAX recipient, and click ‘OK’. A dialog appears which allows you to enter recipient information.



�



Three fields are relevant in this dialog:

1. Display name - This field is used to store the name of the fax recipient. If you wish to add the company name as well, separate the name and the company by a semi colon (;). This information can then be used in a coverpage or template.

2. E-mail address: This field is used for the actual fax number.

3. E-mail type: Enter ‘FAXmaker’

After entering the correct information click on ‘OK’. The recipient can now be used in FAXmaker.

To access the Windows Messaging phonebook directly from FAXmaker, click on the address book button in the ‘Send Fax’ dialog.

Receiving faxes in the Windows Messaging client

Incoming faxes are automatically forwarded to the user’s inbox. To view new faxes, the user must double-click on the new mail. Faxes can be recognised by the number (fax ID from the sending fax machine) in the subject of the message.

�

Fax received in the Windows Messaging inbox.

To view the fax, double-click on the mail message to make the message window pop up.

�

The message window

The message window displays information regarding the fax (the fax report). Now double-click on the icon to view the actual fax. The fax viewer will load the fax file and you will be able to view it on screen and print it if necessary.

�Advanced Use

Introduction

This chapter is meant for users of FAXmaker who wish to tune their FAXmaker installation� XE "installation" � and get to know all its features.

Personalised Fax broadcasting (fax mail-merge)

FAXmaker is able to send out personalised fax broadcasts using the Mail merge feature of Microsoft Word 95 and 97.

To use this feature, FAXmaker must be setup to use Windows Messaging on the machine that you wish to run the fax mail merge on. Furthermore, you must prepare the following before performing the mail merge:

1. The data source (the list of recipients) that you are going to use (since Word can use ODBC you can access almost any datasource), must contain a field for each record with the email address. The email address must be ‘FAXserver’. There is no need to display this field in the word document, but it must be present in the datasource, so you can instruct Word to merge to the faxserver email address.

2. The datasource must contain the actual fax number to which you wish to send the letter/document. This fax number must be included in the document itself and must be contained with # signs, i.e.

#00,356340764#

Therefore each record in your data must contain a field for the faxnumber. Furthermore, you must insert this field somewhere at the top of the document. (It does not have to be exactly at the top)

To perform the fax mail merge;

1. Start up Microsoft Word and select ‘Mail merge’ from the tools menu. Create the mail merge as you normally would in Word. If you are not sure how to use Word mail merge, check the Microsoft word help.

�

2. After you have created your main document and accessed the data, you can proceed to perform the mail merge. Instead of printing it to a printer, the mail merge must be merged to ‘Electronic Mail’. To do this click on ‘Merge’, and in the ‘Merge to’ dialog box, select ‘Electronic mail’.

�

3 Now click on ‘Setup’. Here you must set a number of options for the mail merge. 

�

Mail merge setup dialog.

In this dialog you must select the field that includes the email address, which must be ‘Faxserver’ (The name of the mailbox that FAXmaker uses). The subject line of the message must be ‘mail merge’. This tells FAXmaker to check for a fax number to send out to. In addition, one must select ‘Send document as attachment’, which creates an individual Word document for each attachment.

Click ‘OK’ and perform the merge. Word will send a personalised document to the FAXserver mailbox. FAXmaker will retrieve the faxnumber and send out the faxes.

� XE "Fax server" �Fax server error messages

2000: Error 2000 means: look in Windows NT Event Log for a description. You can also see the description in the FAXmaker Monitor application.

RTF2FAX Errors

Errors relating to the rtf/text/document to fax conversion;

1600  Open File Failed

1601  File not found

1602  Read file failed

1603  Conversion failed

1604  Fax recovery/conversion failed

1605  Already initialised (should never happen!)

1606  Initialisation failed

1607  Coverpage does not exist

1608  The specified Rich text file is not valid

1609  An Unknown error occurred

FAX Server errors

Errors relating to the fax server;

2000  Unable to start the FAX Service. Complete description of the error is given in the Event-Log 

3000L	// invalid window parameter in OpenLine

3001L  // memory allocation failed

-3002L  // driver module not found

-3003L  // driver does not support required functions

3004L	// invalid window parameter in OpenLine

3030L  // invalid line ID

3031L  // function not supported by the driver

3032L  // another task still active on the line

3033L  // PostThreadMessage failed

3100L  // task was aborted with AbortTask

3101L  // ERROR response from device

3102L  // no response from device

-3210L	// Unable to find CAPI2032.DLL

-3211L	// ISDN controller not found

3213L	//open board init failed

-3214L	//open line not available

Call accounting

Call costing can easily be done using Excel, Access or any other application that can read ’CSV’ (comma separated values) files. FAXmaker logs all incoming and outgoing faxes in the following two files: Sendlog.txt and Rcvlog.txt. The files are located in the FAXmaker ‘System’ directory. Using the information in those files, a detailed report can be made.

Send log file

The following information is stored for each outgoing fax;

Date,Time,SenderEmail,SenderName,BillingCode,RemoteId,RecipientName,RecipientCompany,RecipientNumber,CallDuration,PagesTransferred,Result,Info,Port,FilesInArchiveDir.

For example:

"22/12/96","22:18:16","nick@gfitest","nick","","88888888","nick","gfi","nick_gfi_23 <fax@gfitest>","00:30","1","SUCCESS","Fax has been sent successfully","COM2",""

Receive log file

The following information is stored for each incoming fax:

Date,Time,RemoteID,CallDuration,PagesReceived,Result,Info,Port,FileInArchiveDir,RoutedTo.

For example;

"21/12/96","20:14:03","88888888","00:39","1","SUCCESS","Fax received","COM2","","nick@gfitest,alexm@gfitest,bart@gfitest"

Excel macros to analyse log file

Registered users will be able to download a set of Excel macros from our website. These will analyse the FAXmaker send and receive logs. They are scheduled to be available by the end of May 1997. Please check our web site for availability. The macros will only be available to registered users.

Internet site http://www.gfifax.com  

Tips for using FAXmaker and further information regarding technical support can be found on our web site:

http://www.gfifax.com.

The web site will always have the most up to date listing of tips and support questions.

If you have a technical question, please send an e-mail to support@gfifax.com.

�Designing � XE "templates" \r "D2HBtemplates43" �CoverPages & Templates

Introduction

Templates and coverpages can be customised� XE "cover page" \r "D2HBcover_page29" � in order to include your company logo, sender and recipient fields, message fields and any bitmap images. Apart from making a completely new coverpage or template, it is also possible to edit the existing templates included in FAXmaker.

The administrator can store coverpages and templates, and set them as default for all FAXmaker users. The administrator can also set personalised coverpages and templates for each user separately.

Using a coverpage or a template

If you are NOT using FAXmaker integrated with Windows Messaging: 

Do not use the ‘Coverpage Setup’ in the ‘User Configuration’ applet, as FAXmaker will only make use of templates. When a user instructs FAXmaker to send a coverpage in the ‘Send Fax’ dialog, FAXmaker will in fact use the defined template to send it out. The result will be the same as using a coverpage, namely the RTF Template file will be merged with the recipient information and the message text, and will be sent out before the other pages.

If you are using FAXmaker integrated with Windows Messaging:

You can use both the ‘Coverpage Setup’ and the ‘Template Setup’ in the ‘User Configuration’ applet. However, in practice template files will be used most often, because when sending a fax from Windows Messaging, the e-mail message text and sender information will be merged with the defined Template file. Only if a user wants to send another page in front of that page, the user can make use of a coverpage.

Designing a coverpage or template

FAXmaker uses a standard ‘rich text format’ file as a template to create cover pages. 

The rich text format (RTF� XE "rtf" \r "D2HBrtf41" �) is a standard amongst word processors and is supported by virtually any word processor, including MS Word, Amipro and Wordpad (included in Windows 95). This means that you can create your template in your favourite word processor, and just include merge fields such as  <R_Name>, <R_Company> and <message> where you wish to have the actual names and/or information inserted. 

For example a very simple coverpage with recipient name and company could be created as follows:

To: 			<R_Name>

Company:		<R_Company>

Supposing you want to send a fax to Pete Johnson at York computers, the fax would be sent out as follows:

To: 			Pete Johnson

Company: 		York Computers

The merge fields in the RTF file are replaced by the recipient information and then the coverpage is converted to fax format.

(The easiest way to design a cover page is to adjust one of the samples included with FAXmaker in the coverpage directory. To do this simply open up one of the coverpages in your word processor, for example Wordpad, and move around, add or delete merge-fields and/or text as you wish. 

After you have finished designing your cover page, save the template as an RTF file, and assign it to a user. This can be done from the ‘User Configuration’ applet (See Chapter ‘User Settings’).  If you wish to make a default template for the entire company, modify the file template.rtf in the FAXmaker\system\coverpge directory. If you wish to make a default coverpage for the entire company, modify the file coverpge.rtf in the FAXmaker\system\coverpge directory.

TIP: Use Wordpad or MS Word to design your coverpages/templates. FAXmaker uses conversion technology used by these applications also, and therefore it will give you “what you see is what you get” (WYSIWYG).

�

The rtfcvt32 utility lets you quickly convert your coverpage/template and preview the result of your artistic efforts.

TIP: use the rtfcvt32.exe program located in the FAXmaker directory to preview� XE "Preview" � your template/coverpage as a fax file. 

Supported merge-fields

The following merge-fields �may be used in the RTF file.

Sender fields: 

These fields are replaced by the sender information:



Address Fields�Merge code��Last name�<S_Last_name>��First name�<S_First_name>��Name�<S_Name>��Company	�<S_Company>	��Department�<S_Department>��Fax�<S_Fax>��Voice�<S_Voice>��Email�<S_Email>��Recipient fields

These fields are replaced by the recipient information:



Address Fields�Merge code��Company�<R_Company>��Name	�<R_Name>��Fax�<R_Fax>��General fields

These fields are replaced by general information:

Message text:		<message>

This field inserts the text of the coverpage as entered in the ‘Send Fax’ dialog. Be sure to leave enough space in the RTF file.

Current time:		<time>

Current date:		<date>

These fields insert the date and time of the fax. Please note that the date and time of the server machine will be used.

Subject:			<subject>

This field inserts the subject line of the message

Tips on designing a cover page

When designing your cover page in RTF format, please take note of the following:

( To preview your coverpage as a fax, use the rtf2fax program located in the FAXmaker directory.

( Remember that RTF does not support tables and/or headers/footers.

( Remember that merge fields are replaced by the actual field values. Therefore, if you do not leave sufficient space, long names can mix up your formatting.

�

Example of a coverpage with merge- fields

�Sending Faxes 

Benefits of sending faxes with FAXmaker



FAXmaker allows users to send and receive faxes directly from their PC, without having to print the document first, walk to the fax machine, type in the fax number and reschedule at a later stage if the number is busy.

Instead, FAXmaker uses a Fax server� XE "Fax server" � computer, located on your network, which is assigned all Fax related jobs, and also allows you to send and receive faxes at the same time!

The benefits

You no longer need to print out a document prior to faxing it.

FAXmaker will automatically retry fax numbers if they are busy.

Your faxes are more legible and of a better quality, since they are sent directly from your PC, using high resolution� XE "resolution" � techniques.

Incoming faxes can be automatically routed to you as soon as they are received.

Only you can view your outgoing and incoming faxes.

You can easily send faxes to groups� XE "Groups" � of people. 

Ways to send a fax

There are two ways to send a fax with FAXmaker:

1.  Create or open a document in any Windows application and print it on the ’FAXmaker printer’. This automatically activates the FAXmaker ‘Send Fax’ dialog from which you can send the fax.

 OR:

2.  Type in the text the FAXmaker ‘Send Fax’ dialog.

Sending a Fax from an Application

Sending a fax from a Windows application is a simple process. You can make a document in your word processor or any Windows application, and then fax it using FAXmaker's printer driver. If you can print the document in Windows, you will be able to fax it with FAXmaker. 

To fax from a Windows application, follow the following steps:

( As administrator you could try it out by faxing your registration� XE "registration" � form to GFI FAX & VOICE (FAXmaker\system\register.doc).

1.  Start Wordpad.

2.  Enter some text or open an existing document.

3.  Choose the FAXmaker printer driver as your current printer (The FAXmaker printer driver is a mechanism which stores your document as a fax file): From Wordpad's 'File' menu, choose 'Printer Setup'.� XE "Setup" � Select the FAXmaker printer driver and choose 'OK'.

�

Selected FAXmaker printer driver

4.   Print your letter:

a.  From Wordpad 'File' menu, choose 'Print'. In the 'Print' dialog box, click on 'OK'. 

b.  Immediately after the printer driver has printed your document, the FAXmaker ‘Send Fax’ dialog appears. 

�

The Sendfax dialog

5.  The recipient data and fax number can be entered directly in the To: and FAX#: field, or the address can be selected from the FAXmaker phonebook.

To select a recipient from the FAXmaker address book;

a. Click on the 'Phonebook’ tab.

b. The Phonebook tab contains a list of recipients of the currently opened phonebook. 

c. To select a recipient, highlight the recipient and select 'Add'

d. The recipient is now added. You can repeat this process to add multiple recipients.

�  

Selecting a  fax from the FAXmaker address book.

6.  You can attach files to your message using the ‘Attach’ function.

( When attaching files other than FAXmaker fax files, make sure that all fonts and objects that you included in your document are also available to the server. For more information on this, please consult the paragraph ‘Configuring the document converter’ in ‘The Fax server’ Chapter, or contact your administrator.

8. Specify a subject for the FAX. This will allow you to recognise the fax when you receive notification regarding the status of the FAX, and when your fax is archived.

9.  When you are ready, click on the 'Send' button. The fax will be sent by FAXmaker, and you will receive a message when it has been sent successfully.

Sending a fax from FAXmaker

To send a fax from FAXmaker, follow the following steps:

1.  Start up the FAXmaker client.

2. Click on the 'Coverpage' tab. Enter the text you wish to fax.

3. When you are ready, click on the 'Send' button. The fax will be sent by FAXmaker, and you will automatically be notified on the status of the fax.

( If you wish to send a fax to a recipient and have the recipient company name appear on the cover page - you must specify name and company.

Specifying additional recipients for the fax

You can specify multiple recipients by selecting additional recipients from the FAXmaker phonebook.

This is an easy way to send out fax mailings, as FAXmaker will merge the recipient information with the set Template file. Another way of sending out fax mailings is by making use of the mail merge function in MS Word. This process is explained in the Chapter ‘Advanced Use’.

Creating a Fax Attachment

Attachments can be useful when certain information is frequently faxed, such as product brochures. As these can be graphics intensive, it makes sense to convert them only once to fax format and store them as fax attachments on your computer. 

To create a fax attachment on your own computer:

1. Start the application in which the document is saved.

2. From the application menu, choose 'Print Setup'� XE "Setup" �

3. Select the FAXmaker printer driver and click ‘OK’. The FAXmaker ‘Send Fax’ program will now pop up.

4.� XE "Pop up" � Click on the 'Options’ tab. The file will appear in the ‘Attachment list’.

�

Creating a fax attachment

5. To save the fax as an attachment, simply click on the file, and then on ‘Create’. This will automatically convert the file to fax format and list it as an attachment in your attachment list.

Specifying coverpages

FAXmaker includes a default coverpage which you can modify to include your company logo etc. You can however have multiple personalised coverpages, which for example include your signature.

To set this up, you need to design an RTF file and save it as a template (not a coverpage!) in the ‘Template Setup’ from the ‘User Configuration’ applet. (Please contact your administrator for this, or consult the Chapter ‘User settings’). 



Then you must enter the name of the TEMPLATE at the top of the ‘Coverpage tab’ in the ‘Send Fax’ dialog (see below). This list is not automatically updated, i.e. if you add or delete the template at server level, this list will not contain the name of the template added. You will have to enter the name once which automatically add it to the drop down list of coverpages. Then, the next time you wish to use the coverpage, you need only select the name from the drop down list.



�

A coverpage text which will to be sent out using a template file

( When you activate the ‘Send Coverpage’ option in the ‘Send Fax’ dialog, FAXmaker will in fact use a template (template.rtf) file to send out the first page of your fax, and not a coverpage file. Therefore, if you want to add coverpages to be used in the client (from the coverpage tab), you must add templates in the ‘Coverpages tab’, and not coverpages.

This is confusing but inevitable, since FAXmaker for Networks now also includes a Windows Messaging fax gateway.

�� XE "Phonebook" \r "D2HBPhonebook89" �The Phonebook

Introduction

One of the most useful features of computer based faxing is that, using a phonebook, you do not need to re-key the fax number each time you send a fax. By typing the name of the recipient in the send fax window, the fax number is automatically found.

The phonebook enables you to store and manage lists of recipients and their particulars. Each person in the phonebook is called a Record. You can add an unlimited amount of records to your phonebook, and you can group recipients together using the ‘Group function’. You can import� XE "Import" �� XE "Import" � and export� XE "Export" �� XE "Export" � data easily to and from the Phonebook.

To start the Phonebook, click on the 'Phonebook' tab located in the ‘Send Fax’ window� XE "Fax Manager" �.

Managing Individual recipients

� XE "Adding records" �� XE "Adding records" �Adding records

To add a Record:

1. Click on the 'Phonebook' tab in the ‘Send Fax’ dialog.

2.  Select the phonebook to which you are going to add a Record by selecting it from the list box with the mouse.

3.  Hit the ‘Insert’ key, or click on the 'Options' button and select ‘New record’.

�

Edit record dialog

4.  In the 'Edit Record' dialog box, type in the person's address details 

5.  When you type in phone, fax or data numbers, make sure you type in the complete number including country entry codes for overseas faxing. These should be followed by an appropriate separator, such as a comma or a hyphen (, or -). Please consult your fax modem manual for accepted pause separators. 

6.  Click on 'OK' to register� XE "Register" �� XE "Register" � your new Record.

The new Record should now be displayed with rest of the other Records in the Phonebook. 

Finding Records

You can search for records, by typing in the first few letters of the name or company. FAXmaker will automatically highlight the corresponding recipients. To search for a name sort on name by clicking on name. To search for a company, sort on company first by clicking on 'company'.

�

Finding a record by typing the first part of the name in the Find edit box.

Sorting Records

You can sort records alphabetically, either according to 'name' or to 'Company', by clicking on name or company respectively at the top of the phonebook tab.

Deleting Records

To delete a Record:

1. From a particular phonebook file, select a Record by clicking on it. If you want to delete more than one Record, hold down the 'Shift' key whilst clicking with the mouse.

2. Hit the ‘Delete ‘ key, or click on the 'Options' button and select ‘Delete record’.



Groups

Groups are collections of individual Records. Groups can be used to create fax broadcasts to a group of people.

Adding Groups

To add a group.

1.  In a particular phonebook, select any amount of records which you wish to add to the group using the mouse. To select multiple records simply use the SHIFT or CTRL button.

2. Click on the 'Options' button and select ‘To group’.

�

Adding records� XE "Adding records" �� XE "Adding records" � to a group 

3.  In the 'Select Group' window, enter a name of a new group or select an existing group.

4.  Click on 'OK'.

Deleting Groups

To delete a Group:

1. Select the group from the 'Current group' list at the top of the FAXmaker phonebook tab.

2. Select all the recipients, by clicking ‘Options’ and then ‘Select all’, or by using the mouse.

3. Hit the ‘Delete’ key, or click ‘Options’ and select ‘Delete record’. Deleting all the recipients in a group will automatically delete the group also.

Selecting a group to send a fax to

After having created a group, you can select a group and send all recipients the same fax in the following manner:

1. Select the group from the Current Group list box at the top of the Phonebook tab.

2. All the members of the group will be displayed and automatically selected. You can deselect one or more members if you wish.

3. Click ‘Select’ - this will add all the members of the group to the recipient list.

Phonebooks

Making a new Phonebook

FAXmaker can have any number of phonebooks. 

To make a new Phonebook:

1. Click on the 'Options' button and select ‘New phonebook’.

2. In the 'New Phonebook' dialog box, under the 'File Name' field, type a file name. To create a shared phonebook (shared by all FAXmaker users), select 'Global phonebook'.



�

Deleting Phonebooks

To delete a phonebook;

1. Click on the 'Options' button and select ‘Delete Phonebook’.

Saving Phonebooks

You do not need to save phonebook files. Whenever you add, delete or edit Records or Groups within a particular phonebook file, the adjustments are saved automatically. 

Exporting Phonebooks

You can export� XE "Export" � FAXmaker phonebooks to ASCII file formats.

1.  Select the Records you want to export. When you want to select more than one Record, hold down the 'Shift' key whilst clicking on the Records with the mouse.

2. Click on the 'Options' button and select ‘Export to ASCII file’.

3.  In the 'Export to ASCII File' dialog box, select the directory which will contain the new database file. Type in a file name and click on 'Save'.

4.  Click on 'OK'.

Importing ASCII files

To illustrate the procedure of importing Records from another application, follow the subsequent procedure. 

1.  Select the phonebook� XE "Phonebook" � file which you wish to import the records in.

2. Click on the 'Options' button and select ‘Import from ASCII file’.

3.  In the 'Import' dialog box, select the directory which contains the ASCII file you want to import. Choose the file and click on 'OK'.

4. The ASCII file must contain a record on each line of the file, with the fields delimited by "" and separated by a comma. If you do not have any data for a particular field, you must still include "" followed by a comma. This will signify that the field is empty.

"Firstname","Lastname","Company","Department","Email","Fax number","Voice number"

Therefore a file with for example 3 records which need to be imported will look like this;

"Paul","Bates","Open Computing","","","00,44-1132513030",""

"","Adele","Open","","","00,44-1132513030",""

"Andy","Tung","ETEN","","","00,886-2-2975230",""

5.  Click on 'OK' and wait a few seconds until the Phonebook processes the new Records. The imported Records will be then displayed in the main Phonebook window.

�� XE "Fax Manager" \r "D2HBFax_Manager81" �The Fax Manager

Introduction

The Fax Manager allows you to view� XE "View" \r "D2HBView71" � incoming and outgoing faxes from your desk top. 

�

The Fax manager

Viewing sent and received faxes

The Fax Manager allows you to view your mailbox, where all incoming and outgoing faxes are stored.

In Windows 95/ NT 4, the FAXmaker ‘Fax manager’ allows you to access your mailbox from the “tray icon”, located in the bottom right corner of your screen. Double-clicking on this icon will display the Fax manager.

Start up

Start the Fax manager by double clicking on the 'Fax Manager' icon located in FAXmaker Client group, or by right-clicking on the icon in the bottom right-hand corner of your screen..

The pop up menu

For each fax entry, there are a number of options such as viewing or printing a fax. These options can be accessed from the toolbar, but also by highlighting the fax and right clicking your mouse. This will bring up the Pop up menu with a list of options.

�

A Fax entry with the pop up menu 

Viewing faxes

To select a Fax to view, double-click on it. This will automatically load the fax in the FAXmaker viewer.

Deleting faxes

To delete a fax:

1.  Select the fax and click on the 'Delete' icon or hit the delete key.

Resubmitting a fax

At times, it could happen that you need to send a fax again, because the fax number was incorrect, or the fax failed for another reason. In this case, all you need to do is select Resubmit, by highlighting the fax and right-clicking your mouse. This will bring up the pop up menu with the resubmit function. Here you can change the fax number if necessary, and resend the fax by clicking on ‘Send’.� XE "Resubmit" \r "D2HBResubmit82" �

Printing a Fax

To print a fax:

1.  Select the fax and click on the 'Print icon' or select Print from the right-click pop up menu, or from the ‘Event’ menu.

Routing/Forwarding faxes

Routing/Forwarding a fax

When you route� XE "Route" �� XE "Route" \r "D2HBRoute72" � a fax or a message, you are in effect moving that fax from your own mailbox to that of a colleagues on your network. You can only route incoming faxes. 

( It is important to remember that when you route a fax or message, you are moving that event from your mailbox. If you only want to copy an event to a colleague's mailbox, choose the 'Forward' function from the 'Event' menu. The procedure to follow when forwarding an event is identical to the routing procedure.

To route/forward a fax:

1.  Click on the fax you want to route/forward.

2.  Right-click your mouse and select route/forward from the Pop up menu, or select route/forward from the ‘Event’ menu.

3.  Select the person to whom you want to route the event and click on the 'Add' button. (When you want to route the same event to a number of people, repeat this procedure for every recipient.)

4.  The selected recipients will then appear in the list box directly beneath. To exclude a previously selected person, click on the 'Remove' button.

5.  When your recipients are selected, click on the 'OK' button to route the event.

Printing a list of sent and received faxes

1.  Choose 'Export Log' from the 'File' menu. The Windows Notepad application is automatically activated and contains a text transcript of all sent and received faxes in your mailbox.

2.  Choose 'Print' from the 'File' menu in Notepad.



�The FAXmaker DDE API

Introduction

Both the 16 and 32 bit version of the FAXmaker client include a DDE interface which allows you to integrate FAXmaker into your application. DDE (Dynamic Data exchange) is a Windows specification that allows applications to communicate with each other. Using the DDE will enable FAXmaker users to save text files in a certain directory, which FAXmaker will automatically ‘pick up’ and fax out.

Steps needed to automate faxing

You must write a macro in your application that does the following;

a. Ensure that the FAXmaker client is active.

b. Print the document that is to be faxed to the FAXmaker printer driver

c. Initiate a DDE channel with the FAXmaker client

d. Send the name and number of recipient tot  the FAXmaker client

e. Send any necessary fax options to the client and send the fax

f.  Close the DDE channel.

Sample Macro in Word

Sub MAIN

REM Change print to FAXmaker printer

	FilePrintSetup .Printer = "FAXmaker on GFI"

REM Print active document

	FilePrint

REM Connect to the client

	Channel = DDEInitiate("FMCLIENT", "SENDFAX")

REM Add recipient in the client

	DDEPoke(Channel, "ADD", "Support|GFI FAX & VOICE|00,44-1819440025")

REM Send the fax with cover page, low res

	DDEPoke(Channel, "SEND", "0111")

REM Terminate connection

	DDETerminate(Channel)

End Sub

This sample macro prints the active document to the FAXmaker printer driver, then adds a recipient to the fax and sends it.

Available options/switches;

The SEND command which one activates as the last command, has 4 ‘flags’ which can be set;

The four flags (1 on/0 off):

	- Send in highresolution

	- Send Cover page

	- Popup to confirm sending (activates ‘Send Fax’ window)

	- Wait for fax-attachment from printer driver e.g. ( in word basic )

This sends with a cover page, in high resolution,

will not popup, will not wait:

DDEPoke ( Channel, "SEND", "1100" )

This pops up the client with a cover page and 

in normal resolution immediately:

DDEPoke ( Channel, "SEND", "0110" )

This sends without a cover page and in high resolution,

will wait for printing to be ready:

DDEPoke ( Channel, "SEND", "1001" )

This sends without a cover page and in normal resolution,

will not popup, will not wait:

DDEPoke ( Channel, "SEND", "0000" )

�� XE "Viewer" \r "D2HBViewer61" �The Viewer

Introduction

With the ‘FAXmaker Viewer’, you can view, print and save fax files. The FAXmaker Viewer can be activated by double-clicking on the fax file in the ‘Fax Manager’, or if you are using Windows Messaging, on the Fax attachment displayed in the e-mail message. 

Viewing Faxes

The viewer can be used to:

1.  View incoming or outgoing faxes by double-clicking on the fax file� XE "Fax Attachment" � in the FAXmaker ‘Fax Manager’ or on the Fax attachment in the e-mail message (Windows Messaging). The FAXmaker Viewer is automatically activated and will display the fax on your screen.

2. Preview� XE "Preview" � outgoing faxes by double-clicking on the fax attachment in the ‘Send Fax’ dialog. The FAXmaker Viewer is automatically activated and will display the fax as it will be sent.

In the Viewer itself you can:

a.  Preview pages one by one, using the 'Next' or 'Previous' command from the 'Page' menu. When your document is made up of one page, these functions will be dimmed.

b.  Re-size the document on your screen by choosing either the 'Horizontal Fit' or the 'Vertical Fit' from the 'View' menu.

c.  Zoom in or out whilst viewing the document from a number of view points by choosing an appropriate zoom value from the 'View' menu. 

d.  Invert the image by choosing the Invert command from the 'View' menu.

e. Flip the image if the fax was received upside down.

f.  Print the document to your local printer by choosing the 'Print' command from the 'File' menu.

g . Save the fax on your hard disk. Choose the 'Save as' function from the 'File' menu (or click on the 'Save as' icon) and type the file name in the 'Save as' dialog. You can save documents in '*.fax', '*.tiff' or '*.dcx' file format. Choose 'Exit' from the 'File' menu.

Scale to Grey

The advanced fax viewer, available for Windows 95 and NT 4, includes a scale to grey option (located in the view menu), which allows you to view the fax at a much higher resolution.� XE "resolution" � 

Fax annotation

In Windows 95 or NT 4, you can annotate faxes using the advanced FAXmaker viewer. The following annotation tools are at your disposal:

�

Annotation tools

1. Select ‘Annotation’.

2. Draw freehand line.

3. Highlight a particular section of a fax.

4. Draw a straight line.

5. Draw a rectangle.

6. Draw filled rectangle.

7. Add text to a fax.

8. Attach a note.

9. Add text stored in a file.

10. Add a stamp.



� EMBED Word.Picture.6  ���



To change any of the default tools, right click your mouse above a tool and select properties. The default stamp texts can for instance be changed in this way.



( Save your annotations! Your annotations are only made permanent if you select ‘Save’ from the menu.



.�

The FAXmaker viewer in Windows 95/NT 4

Platforms other than Windows 95/NT 4 do not include annotation.� XE "annotation" \r "D2HBannotation59" �

�Troubleshooting

Modem problems

“The modem does not dial out.”

In some cases your modem may not dial out, returning the error message “No dial tone”. The problem could be caused by the fact that not all export� XE "Export" � modems recognise the dial tone. To solve this, disable “Wait for Dial Tone” in the Fax setup� XE "Setup" � window of the server, as explained in the Chapter ‘The Fax server’.

“Many faxes fail - can I adjust any settings in FAXmaker to improve this?“

Most of the modem problems are due to modem-command delay-time. 

On-line, the delay is very critical for a few modems.

There are two indications that delay might be a problem:

 1. The modem does not respond to a command (error -3102).

 2. The carrier is dropped, i.e. the connection is lost.

You can see this from the modem lights: the Carrier Detect light will turn off.

The TIA/EIA class 2 specification states that:

"the DCE may fail to recognise a command line if the start element of the first character of the command line begins within one millisecond of one half-bit time into the stop element of the terminating character of the final result code character issued in response to the preceding command line".

The TIA/EIA class 2.0 specification states that:

"the DTE shall not issue a new command line until the DCE has finished delivering the complete final result code to the previous command line, including any following <cr> and <lf> characters".

However, there is no mathematical rule to calculate the delay-time. When a modem is offline, FAXmaker uses a long delay before it releases a new command (60ms) and in between two characters (20ms). These delays are definitely long enough for all modems. The problem is not when the modem is offline. The problem is when the modem is on-line. When on-line, the delay has to be long enough so that next command will be accepted, but not too long because the modem might drop the carrier because it does not receive a command. This behaviour is different amongst the modems on the market. Also, some commands require a longer delay than others on the same modem.

There are a lot of differences between modems. The behaviour not only depends on the modem-type only, but also on the EPROM-version of the modem. Because GFI cannot test all different modems/EPROM versions, you can change the delay in the debug-utility and see if it solves your problem.

The default pre-command delay (/X) is 20ms, the default delay between two characters (/Y) is 10ms. If you use /X and /Y, please try the following combinations:

	/X 0  /Y 0

	/X 5  /Y 0

	/X 20 /Y 5

If you try these three combinations, most probably your problems will be solved.

You can make this change into FAXmaker by adding another line into the <FAXMAKER>\MODEMS.INF file. The syntax of a line is Name,type,initstring,precommanddelay,interchardelay,voiceformat,voicebitspersample,voicesamplefreq

Let's say you have problems with your class-2 modem 'XYZ' and you got it to work with params /X 20 /Y 5, then add the following line:

	XYZ=class232,AT&F,20,5,0,0,0

Modem Debug Utility

To assist you in improving the mode performance, GFI FAX & VOICE have created a “debug” utility which allows you to easily send and receive faxes from the command line/console. This application also creates a so called debug file, which you can send to GFI FAX & VOICE via email. This debug file will then include valuable information which would allow us to assist you in getting the modem to perform better.

This utility can be found on GFI FAX & VOICE’s web site, by going to the support area on http://www.gfifax.com (follow the link support).

FAQ on http://www.gfifax.com  

A FAQ is a list of frequently asked questions. GFI FAX & VOICE maintain a support FAQ, which lists answers to most common problems. If you have a problem with FAXmaker and have access to the INTERNET, please read this FAQ first. 

The FAQ’s website URL is http://www.gfifax.com/pages/fnfaq.htm. The 

The web site will always have the most up to date listing of support questions and patches.

How  to request for support

If, after using the FAQ and this manual, you have any problems which you cannot solve yourself, please send an e-mail to support@gfifax.com. We will send you a reply as soon as possible.

Be sure however to register your product on the web site first, at http://www.gfifax.com/pages/regfrm.htm.

You can also contact your dealer or distributor or contact one of GFI’s offices.
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